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But du document 
 

Le guide suivant vous aidera à mieux comprendre et à utiliser le programme de conditionnement 

physique des plongeurs-démineurs (PD), un programme d’entraînement physique de 12 semaines 

adapté au Centre d’évaluation des plongeurs-démineurs (CE PD). La version papier se trouve à 

l’annexe B, et une version électronique se trouve sur l’application mobile Kinduct Athlete. 

 

Le Programme de conditionnement physique des plongeurs-démineurs vise à développer une capacité 

de travail faisant état des exigences du Centre d’évaluation des plongeurs-démineurs tout en soutenant 

la résilience physique dans le but de réduire les blessures. L’entraînement à la résistance mentale est 

intégré à l’approche de ce programme, de sorte que vous développez progressivement un sentiment de 

contrôle sur votre préparation physique, votre engagement dans le processus d’entraînement, votre 

capacité à relever les défis et votre confiance dans la réalisation de vos objectifs. Par ailleurs, un 

programme d’entraînement physique de maintien/de transition pour la période entre le Centre 

d’évaluation et le cours pour devenir plongeur-démineur sera disponible au printemps. 

 

L’application mobile Kinduct Athlete vous fournira votre programme d’entraînement physique, avec des 

explications et des vidéos, directement sur votre téléphone intelligent. Vous pouvez télécharger 

l’application mobile Kinduct Athlete sur votre téléphone intelligent en suivant les instructions à la 

section 1 de l’annexe A du présent document. 

 

Pour optimiser et personnaliser votre préparation, vous aurez également accès à un suivi quotidien de 

votre préparation et de votre mieux-être. Ces questionnaires prennent moins d’une minute à remplir et 

visent à surveiller la qualité de votre sommeil, votre fatigue, la douleur, l’échelle de perception de 

l’effort (ÉPE) et la charge d’entraînement. Vos réponses individuelles peuvent aider le professionnel de 

la santé des PSP à ajuster votre entraînement en fonction de ce que vous ressentez ce jour-là ou cette 

semaine-là, afin d’éviter le sous-entraînement ou le surentraînement. 
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Appui des Programmes de soutien du personnel (PSP) 
 
Les représentants du conditionnement physique des PSP de la base attitrés aux plongeurs-démineurs 

vous aident à : 

1. prendre conscience des demandes et des exigences liées à la préparation en vue du Centre 

d’évaluation des plongeurs‑démineurs et du cours connexe afin d’améliorer les possibilités de 

réussite au cours; 

2. obtenir des conseils et un soutien sur la formation en général, et plus particulièrement en ce qui 

concerne le programme de préparation à la condition physique du plongeur‑démineur de 

12 semaines (annexe B) : 

a. suivre ou modifier le programme de 12 semaines en fonction de vos forces, de vos 

faiblesses, de vos restrictions professionnelles, de vos limitations physiques (en cas de 

blessures déjà existantes), etc., 

b. établir et optimiser des stratégies et de bonnes habitudes en matière de sommeil, de 

nutrition, de soins des tissus mous et de force mentale. 

3. utiliser des outils de suivi quotidien de la préparation et du mieux-être de l’athlète (qualité du 

sommeil, fatigue, douleur et échelle de perception de l’effort (ÉPE)/charge d’entraînement de la 

séance) pour vous aider à prendre en charge votre entraînement. Bien que le programme de 

conditionnement physique ait été conçu sur la base des exigences absolues du cours et du 

métier de plongeurs‑démineurs, mais peut être modifié (intensité, rétablissement, modalité, 

etc.) selon vos réponses aux questionnaires sur la préparation et le mieux‑être. 

 

Contexte - Élaboration du Programme de conditionnement physique 
des plongeurs‑démineurs 
 

Les plongeurs-démineurs des Forces armées canadiennes sont des spécialistes hautement qualifiés de la 

plongée et de la neutralisation des explosifs et des munitions (NEM) qui fournissent à la Marine royale 

canadienne (MRC) et aux commandants opérationnels des capacités de guerre spécialisées au pays et à 

l’étranger. Les principales capacités comprennent :  

1. Les opérations de lutte contre les mines en localisant, en identifiant et en neutralisant des 

menaces d’explosion de mines sous-marines; 

2. La neutralisation des explosifs et des munitions non explosés et improvisés en surface et 

sous la surface; 

3. Les réparations, l’entretien et l’inspection sous marins des navires et installations navales; 

4. Les composantes de protection de la force sous-marine pour les FAC et d’autres 

organismes gouvernementaux; 

5. Soutien au COMFOSCAN. 

En 2019, la MRC a demandé le soutien de la Direction du conditionnement physique (DCP) des Services 

de bien-être et moral des Forces canadiennes (SBMFC), afin de fournir une expertise en la matière lors de 
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l’examen du processus de sélection des plongeurs-démineurs de la MRC par la Direction générale – 

Recherche et analyse (Personnel militaire) [DGRAPM]. On a demandé à la DCP des PSP de contribuer à la 

refonte des composantes physiques du processus de sélection, des évaluations en vue de la sélection et 

d’un programme de préparation physique.
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Recherche 
 

Le Centre d’évaluation des plongeurs-démineurs (CE PD) est extrêmement exigeant, tant sur le plan 

physique que mental. Il est fortement recommandé aux candidats potentiels du CE PD de se préparer 

physiquement à l’aide du guide du programme de conditionnement physique des plongeurs-démineurs 

en vue du CE PD. 

 

Les exigences physiques et physiologiques du CE PD ont été identifiées tout au long d’un examen du cours 

de niveau de qualification 5 (NQ5) des plongeurs-démineurs en 2019-2020 afin d’élaborer le CE PD. Des 

experts du CE PD ont été consultés pour définir en détail les exigences physiques de chacune des phases 

du cours avec un contexte lié à des missions opérationnelles et des exercices d’entraînement réalistes 

mais exigeants. Des observations et des mesures ont été effectuées pendant le cours NQ5 des 

plongeurs-démineurs. 

 

En étroite collaboration avec les spécialistes de la qualification des plongeurs-démineurs, la recherche a 

été utilisée pour élaborer les éléments physiques du CE PD et formuler le programme de 

conditionnement physique présenté dans ce guide. Ces éléments physiques sont propres aux capacités 

physiques requises par les candidats se soumettant au CE PD et les candidats au cours. 
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Sommaire des exigences physiques du cours de plongeur‑démineur 
 

Tableau 1. Analyse des mouvements des tâches des plongeurs‑démineurs les plus exigeantes sur le plan physique. 

Mouvement principal  Description de la tâche 

Locomotion avec port de 
charge externe (sac à dos de 
45 kg)  

 Se tenir debout, marcher sur un sol inégal sur des terrains variables (sable, bois, gravier) en suivant 
l’infanterie légère lors d’une patrouille à pied pour la neutralisation des explosifs et des munitions (NEM) et 
la neutralisation d’engins explosifs improvisés (NEEI). Porter une combinaison anti-bombe pendant 
plusieurs heures et transporter une trousse à outils. 

Se tenir debout, marcher, porter de l’équipement de plongée, p. ex. plombs, bouteilles de plongée, 
ensemble de plongée, trousse médicale, jerricanes, outils mécaniques, GPS Shark Marine (jusqu’à 
concurrence de 40 kg). 

 Se tenir debout, marcher sur une surface instable (embarcation gonflable à coque rigide 
(RHIB)/canot Zodiac). 

 Transport d’une civière d’un plongeur blessé lors d’exercices d’urgence dans l’eau. 

Nage avec palmes  Nager en surface pour atteindre le rivage ou longer le rivage jusqu’à 3 km. 

 Nager en sprint pour répondre à des urgences ou pour porter secours à un plongeur. 

Plongée avec palmes  Plongée dans l’océan (avec/contre un courant de 1,5 nœud) sur une distance de 3 km avec un 
GPS (Shark Marine) en eaux peu profondes. 

 Plongée avec un câble de référence, en effectuant des recherches circulaires jusqu’à 81 m de profondeur. 

Hisser du matériel  Soulever de l’équipement lié à la plongée de format inhabituel (p. ex, plombs, bouteilles de plongée, 
ensembles de plongée, trousse médicale, jerricanes, outils mécaniques, GPS (Shark Marine) du sol à la 
hauteur des épaules, du bateau ou du banc en manipulant l’équipement avec soin et précaution (jusqu’à 
40 kg). 
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Tirer  Se hisser hors de l’eau dans une embarcation pneumatique à coque rigide (RHIB)/canot Zodiac. 

Tirer/soulever une victime d’urgence hors de l’eau pour la mettre dans une embarcation pneumatique à 
coque rigide en toute sécurité (88 kg). 

 Amarrer l’embarcation pneumatique et les canots à réaction à la jetée.  

Postures et positions 
inconfortables 

 

 

 Se pencher, se tordre, se baisser, s’agenouiller pour enfiler/retirer l’équipement de plongée. 

Se pencher, chevaucher le canot Zodiac pour s’infiltrer dans une zone d’intérêt pour les opérations de lutte 
contre les mines. 

 Se pencher, se tordre, s’abaisser, s’agenouiller, s’allonger sur le ventre pour effectuer des opérations de 
NEM et de NEEI en surface ou en profondeur, tout en portant une combinaison anti-bombe. 
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Demandes métaboliques du cours des plongeurs-démineurs – Tâches les plus exigeantes sur le plan 

métabolique 

Les exigences métaboliques ont été mesurées tout au long des tâches physiquement exigeantes - 

(1) préparation avant la plongée (2) plongée réaliste, mais exigeante en eaux très peu profondes 

(3) instructions permanentes d’opérations (IPO) de la neutralisation des explosifs et munitions. 

Pour répondre aux exigences métaboliques et physiques du cours NQ5 de plongeurs-démineurs, 

les candidats doivent : 

 Se soumettre à l’évaluation de la condition physique (ECP) en vue de la sélection des 

plongeurs-démineurs en fournissant l’effort maximal; 

 Avoir une capacité aérobique maximale (VO2 max) d’environ 50 à 55 mLO2*kg-1*min-1; 

 Pouvoir nager à une cadence de 2 min 15 s/100 m pendant 1 km; 

 Pouvoir courir à une cadence de 4 min 30 s/km sur une distance d’au moins 5 km; 

 Soulever une charge de 90 kg, à partir du sol jusqu’à la hauteur de la taille; 

 Transporter 30 kg dans chaque main sur une distance jusqu’à 300 mètres (permettant 

les pauses et les réajustements de la prise); 

 Maintenir la position de la planche pendant 150 s. 

Ces attributs métaboliques et physiques soutiennent les candidats lors de l’apprentissage et de 

l’exécution des tâches du plongeur-démineur. Par exemple, lors de la plongée avec l’appareil 

respiratoire à air comprimé (ARAC), la réserve d’air dans la bouteille de plongée est limitée. Le 

plongeur-démineur doit contrôler sa consommation d’air afin d’accomplir la tâche avec succès. Une 

capacité aérobique maximale élevée et une efficacité de nage élevée diminueront la quantité absolue 

d’air nécessaire (fréquence et volume respiratoires) pour accomplir une tâche avec l’ARAC. 

Aspects environnementaux 

Les plongeurs‑démineurs exécutent la plupart de leurs tâches dans des conditions environnementales 

non contrôlées. Notons, entre autres : 

 a température de l’eau : Environnement froid 

 l’état de la mer 

 les missions de jour/de nuit : éclairage sous l’eau 

Ces aspects environnementaux augmentent les exigences métaboliques et physiques d’une tâche. Les 

candidats au cours NQ5 de plongeurs-démineurs doivent posséder une réserve de capacité métabolique 

et physique afin de faire face à ces demandes accrues. 

Indicateurs clés de succès 

D’après les discussions avec la direction des plongeurs-démineurs, les entrevues menées après le CE PD 

et les recherches effectuées sur les exigences physiques, il est fortement recommandé, avant le CE PD, de 

participer à un entraînement physique régulier et de chercher du soutien en matière d’entraînement 
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physique (p. ex. un professionnel du conditionnement physique des PSP) afin d’augmenter vos 

probabilités de réussite au CE. 

Programme de préparation au conditionnement physique 
 

Le programme de conditionnement physique du plongeur-démineur a été conçu en fonction des 

exigences physiques absolues de la participation au CE PD, au cours NQ5 du plongeur-démineur et en 

tant que plongeur-démineur qualifié. Un programme de conditionnement physique de 12 semaines et 

un programme de conditionnement physique de transition/maintien (disponible au printemps) qui fait le 

pont entre le Centre d’évaluation et le cours NQ5 des plongeurs-démineurs ont été élaborés. Chaque 

phase d'entraînement a été conçue avec un objectif et une progression particuliers dans le but de vous 

aider à atteindre la capacité physique nécessaire pour réussir le Centre d’évaluation et le cours NQ5 des 

plongeurs-démineurs. 

 

Le programme de conditionnement physique sera disponible sur l’application mobile Kinduct Athlete 

vers la fin de l’automne (annexe A : section 1) et en version papier (annexe B). L’utilisation de 

l’application mobile Kinduct Athlete vous permettra de visualiser votre entraînement, les vidéos de tous 

les exercices et leur exécution. 

 

Il est recommandé que vous remplissiez également les questionnaires quotidiens. Ces questionnaires 

permettront au professionnel du conditionnement physique des PSP de suivre votre perception de 

l'effort (par séance d’entraînement) et votre progression (par semaine) dans le programme de 

conditionnement physique des plongeurs-démineurs. Ainsi, l’entraînement sera personnalisé en 

fonction de vos forces et de vos faiblesses, ce qui est hautement profitable pour maximiser les 

avantages du programme. Voir la figure 1 comme exemple :  

 

 
Figure 1. Charge d’entraînement relative quotidienne 

 

Pour avoir accès au programme de conditionnement physique, vous devez contacter le professionnel du 

conditionnement physique des PSP désigné pour les plongeurs-démineurs de votre localité ; chaque 
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emplacement/base a un entraîneur des PSP désigné pour les plongeurs-démineurs qui peut vous donner 

accès au programme d'entraînement et au suivi de la préparation et du mieux-être des athlètes. Ce 

professionnel du conditionnement physique des PSP vous fournira également toute autre information 

que vous devez connaître concernant le programme. Si votre base n’a pas de professionnel du 

conditionnement physique des PSP associé aux plongeurs‑démineurs, veuillez communiquer avec Troy 

Grinder, adjoint à la recherche en performance humaine, à Troy.Grinder@forces.gc.ca. 
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Composantes du Programme de préparation au conditionnement physique 
 

Semaines d’évaluation (Semaines 1, 7 et 12) 
 

Les semaines d’évaluation sont essentielles pour déterminer votre niveau de forme initial et évaluer 
votre progression sur les capacités de base que vous devez acquérir spécifiquement pour le CE PD. La 
littérature scientifique et sportive recommande d'effectuer des évaluations physiques et de la condition 
physique entre chaque phase de l’entraînement. Des évaluations ou contrôles réguliers de la condition 
physique permettront d’orienter la progression de l'entraînement afin de réussir le processus de 
sélection des plongeurs-démineurs et le cours NQ5. 

 

Lignes directrices pour les évaluations 
a. Fournir une base de référence de la capacité physique par rapport aux exigences physiques 

requises des plongeurs-démineurs. 
b. Fournir des mises à jour de la progression de la capacité physique afin d’évaluer l’efficacité du 

programme de conditionnement physique des plongeurs-démineurs. 
c. La semaine d’évaluation réduit la charge d'entraînement globale afin de permettre la 

récupération physique.  
d. Toutes les conditions d’évaluation contrôlables (notamment les conditions météorologiques, la 

température ambiante, l’heure de la journée, la nutrition, l’hydratation) doivent être aussi 
identiques que possible entre les évaluations (semaines 1, 7 et 12) afin de fournir une 
performance physique précise et fiable. 

e. Toutes les évaluations devraient être exécutées à un effort maximal. Afin de permettre un effort 
maximal, une seule évaluation par jour est prévue. Une fatigue résiduelle minimale doit être 
accumulée à partir de l’évaluation de la condition physique. 

f. Les évaluations sont : évaluation de la condition physique en vue de la sélection des 
plongeurs-démineurs (composante terrestre), test de fonction aérobie maximale (FAM) de 2 km, 
évaluation de la condition physique en vue de la sélection des plongeurs-démineurs 
(composante aquatique); échauffement approprié avant et retour au calme/récupération après 
chaque évaluation. 

Évaluation de la 
condition physique 
en vue de la 
sélection des 
plongeurs-démineurs 
(composante 
terrestre) : 
 

1- Marche de 5 km avec sac à dos de 35 kg en moins de 60 min 
2- Évaluation FORCE en circuit : 

a. Course précipitée sur 20 m 
b. Soulevé de sacs de sable 
c. Courses-navettes intermittentes avec charge (port de 2 sacs de sable au cours 

des 2 premières CNIC) 
d. Traction de sacs de sable 

3- Soulevé de terre avec haltère de 75 kg, autant de répétitions que possible 
 
***Ressources : suivre ce lien 
 

 Excellent Bon Moyen Acceptable À améliorer 

Évaluation 
FORCE en 

circuit 

5 min 14 s ou 
moins 

5 min 15 s – 
5 min 25 s 

5 min 26 s – 
5 min 50 s 

5 min 51 s – 
6 min 35 s 

Plus de 
6 min 35 s 

Soulevés 
de terre de 

75 kg  
44 ou plus 36 à 43 28 à 35 8 à 27 Moins de 8 

 

Test FAM sur tapis 
roulant de 2 km : 

Évaluation sur le tapis roulant de 2 km à la fréquence cardiaque FAM (dans une fourchette de 2 bpm 
pendant toute la durée) : temps record; 
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***Le pointage est le temps qu’il vous faut pour parcourir 2 km sur le tapis roulant sans aucune 
inclinaison tout en maintenant la fréquence cardiaque FAM. (FAM – Fonction aérobie maximale) 
 
Équation FAM : La formule 180 
 
Pour trouver votre fréquence cardiaque d’entraînement aérobique maximal, deux étapes sont 
importantes. 
1. Soustrayez votre âge de 180. 
2. Modifiez ce chiffre en choisissant parmi les catégories suivantes celle qui correspond le 
mieux à votre profil de condition physique et de santé : 
a) Si vous souffrez ou vous remettez d'une maladie grave (maladie cardiaque, intervention chirurgicale 
ou séjour à l’hôpital, etc.) ou si vous prenez régulièrement des médicaments, soustrayez 10 de plus. 
b) Si vous êtes blessé, si vous avez régressé à l'entraînement ou en compétition, si vous avez plus de 
deux rhumes ou grippes par an, si vous souffrez d'allergies ou d'asthme, ou si vous avez été irrégulier 
ou venez de reprendre l’entraînement, soustrayez 5 supplémentaires. 
c) Si vous vous êtes entraîné régulièrement (au moins quatre fois par semaine) pendant deux ans 
sans aucun des problèmes mentionnés en a) et b), gardez le même nombre (180-âge). 
d) Si vous vous entraînez depuis plus de deux ans sans aucun des problèmes mentionnés aux points 
a) et b), et que vous avez progressé en compétition sans vous blesser, ajoutez 5. 
Par exemple, si vous avez 30 ans et que votre condition correspond à la catégorie (b), l’équation est la 
suivante : 180-30=150. Puis 150-5=145 battements par minute (bpm). 
 

Évaluation de la 
condition physique 
en vue de la 
sélection des 
plongeurs-démineurs 
(composante 
aquatique) : 
 

1- 2 min 30 s de nage sur place sans les mains 
2- 500 m de nage latérale avec palmes 

 
***Ressource : suivre ce link 
 

 Excellent Bon Moyen Acceptable À améliorer 

Nage de 
500 m 

8 min 11 s ou 
moins 

8 min 12 s – 
8 min 31 s 

8 min 32 s – 
9 min 12 s 

9 min 13 s – 
10 m 17 s 

Plus de 
10 min 17 s 
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Entraînement de base (Semaines 2 à 6 et semaines 8 à 11) 
 

Ces semaines d’entraînement permettront de perfectionner votre capacité de travail en misant sur les 
aspects les plus pertinents du Centre d’évaluation de sélection des plongeurs‑démineurs et du cours de 
qualification de niveau 5. Ainsi, vous serez fin prêt sur le plan physique à relever les défis du cours de 
plongeurs‑démineurs et du cours de qualification de niveau 5.1 

 

Directives sur l’entraînement de base 
a. Des lignes directrices sont fournies au sujet de la préparation physique particulière des 

plongeurs‑démineurs sans surentraînement. 
b. Fournit une progression pour les cinq compétences physiques essentielles du CE PD et du cours : 

natation, course, marche avec sac à dos, force fonctionnelle et prévention des blessures. 
c. Les séances d’entraînement (pour chaque jour) peuvent être effectuées séparément ou 

combinées à différents moments de la journée. 
d. Il est recommandé de varier les conditions environnementales lors des séances d’entraînement 

(séances d’entraînement à l’extérieur, séances d’entraînement à différentes heures de la 
journée, etc.) 

e. Chaque séance devrait vous mettre à l’épreuve. 
f. Chaque séance doit comprendre un échauffement et un retour au calme/une récupération. 
g. Pendant les jours de repos/mobilité, il est recommandé de continuer à pratiquer une activité 

physique. La variété de l'activité physique contribue à créer une capacité physique bien 
équilibrée, ce qui aide à réduire le risque de blessures à l’avenir. Les suggestions d’activités 
physiques de récupération sont les suivantes : promenades, randonnées à vélo, sports sans 
contact, etc. 

h. S'assurer de disposer d’une période de récupération suffisante avant le CE PD. Remarque : 
Performance = condition physique - fatigue. 

                                                           
1 Corcoran et Bird, 2009; Deweese et coll., 2015. 
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Spécialiste de la force et du conditionnement physique de la Marine 

Version 4, Août 2022 

Séances 
d’entraînement 

Fréquence Description des objectifs de l’entraînement de base 

Capacité aérobique 
(course ou natation)  

3 fois par 
semaine 
 

Développer la capacité aérobie : augmenter la capacité/l’endurance 
pour maintenir l'effort pendant une longue période et récupérer plus 
rapidement après une période intense. 
 

Puissance aérobique 
(course) 

1 fois par 
semaine 
 

Développer la puissance aérobie : augmenter l'effort maximal de 
puissance/vitesse pendant une période modérée. 
 

Capacité aérobique 
(marche avec sac à 
dos) 

1 fois par 
semaine 
Journée 
suggérée :  
Samedi 
 

Développer la capacité à porter un équipement lourd (jusqu'à 45 kg) qui 
représente la charge d'équipement quasi maximale requise du 
plongeur-démineur. Peut être utilisé comme bilan de la condition 
physique personnelle pour savoir comment vous vous sentez avec le 
port de la veste sur la distance du circuit. 
 

Force/objet 
inhabituel 

4 à 5 fois par 
semaine 
 

Développer/améliorer la force musculaire en utilisant des appareils de 
condition physique réguliers et des objets inhabituels. Développer la 
stabilité musculaire pour manipuler des charges de manière sûre et 
efficace. 
 

Accessoire/poids 
corporel/mobilité 

5 fois par 
semaine 
 

Identifier les limitations de mouvement au début de l’entraînement et 
maintenir une pratique cohérente pour un mouvement efficace. 
Maintenir une bonne amplitude des mouvements dans les hanches et la 
ceinture scapulaire. Développer la stabilité du tronc nécessaire aux 
plongeurs-démineurs. Apprendre à se déplacer avec efficacité permet de 
prévenir les blessures. Tolérance de charges sans instabilité et 
épuisement. 
 

Repos/mobilité/choix 
d’activité physique 

2 fois par 
semaine 
Journées 
suggérées :  
Jeudi 
Dimanche 

Journée de récupération pendant la semaine. 
Développer l’endurance en effectuant une variété de mouvements 
différents dans le choix d’une activité physique. 
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Remarque importante à propos de l’entraînement ciblé 
 

 Capacité aérobique de natation : Comme la plupart des activités des plongeurs-démineurs se 
déroulent dans l’eau, des séances de natation ont été prévues. Au-delà de la natation et de la 
pratique de la technique de nage latérale, le plongeur-démineur doit pouvoir exécuter des tâches en 
toute sécurité pendant une durée prolongée dans l'eau. Par conséquent, une capacité aérobique 
élevée et une réserve métabolique dans l'eau sont essentielles. 
 

 Récupération/mobilité/choix des activités physiques ou sportives : Ces séances sont intégrées 
comme moyen de récupérer de vos journées d’entraînement éprouvantes. Ces séances sont 
comprises dans le programme afin d’augmenter l’endurance globale requise pour le cours NQ5 et 
les opérations des plongeurs-démineurs, de réduire le risque de blessures de surutilisation et de 
promouvoir la variété. Il s’agit de séances importantes. 

 

 Toutes les autres séances d’entraînement ont toutes été conçues pour augmenter progressivement 
la capacité à fonctionner dans l’instabilité, avec une simple partie du corps à différentes intensités 
et selon différents types de mouvement, tels que décrits dans le tableau de résumé des 
mouvements ci-dessous. 
 

 Les questionnaires quotidiens sur la préparation et le mieux-être des athlètes sont inclus comme 
outil permettant de personnaliser votre entraînement en fonction de votre réaction à ceux-ci et de 
votre état de préparation et mieux-être quotidiens. Les professionnels du conditionnement 
physique des PSP peuvent vous soutenir dans ce programme. 
 

 Vos faiblesses : Ce programme ne cible pas vos faiblesses particulières, mais fournit plutôt un 
entraînement absolu pour réussir le CE et le cours. Communiquez avec le professionnel du 
conditionnement physique des PSP de votre base d'attache si vous souhaitez que ce programme soit 
personnalisé pour répondre à vos besoins. 

 
  



 

 

Avant de commencer 
 
Si vous lisez ce guide plus de 12 semaines avant le Centre d’évaluation, vous pouvez demander à votre 
professionnel du conditionnement physique des PSP un programme d’entraînement général pour vous aider 
à vous préparer à ce programme. 
 

 Êtes-vous prêt à utiliser le programme de conditionnement physique des plongeurs‑démineurs? 

 Avez‑vous un niveau de condition physique adapté au métier de plongeur‑démineur, notamment le 
conditionnement physique cardiovasculaire, l’entraînement musculaire et la mobilité? 

 Participez‑vous à des séances de 30 min et plus de 5 à 6 fois par semaine d’entraînement physique 
ciblé? 

 Consultez le programme de conditionnement physique des plongeurs‑démineurs. Est-il beaucoup plus 
difficile que ce que vous faites actuellement? Le programme commence progressivement et augmente 
graduellement pour éviter la surutilisation. 

 
Le programme de conditionnement physique des plongeurs‑démineurs est conçu pour être entamé 
12 semaines avant le Centre d’évaluation afin d’être exécuté dans son intégralité. Il s’agit d’un programme 
d’entraînement progressif et exigeant, qui nécessite un niveau de condition physique bien équilibré pour 
tolérer la charge d’entraînement sans risque accru de blessure. Le soutien d’un professionnel du 
conditionnement physique des PSP qui comprend le programme de conditionnement physique des 
plongeurs‑démineurs vous aidera à optimiser votre préparation. 
 
*Lors de la première semaine d’évaluation, si vos performances se situent dans la catégorie « à améliorer » 
ou si vous avez des difficultés avec la composante aquatique de l’ECP en vue de la sélection des 
plongeurs-démineurs (nage sur place, natation), il est fortement recommandé de prendre les mesures 
appropriées (p. ex. des cours de natation) AVANT de commencer le programme d’entraînement. Vous 
pouvez joindre le coordonnateur des activités aquatiques des PSP de votre localité pour obtenir un soutien 
en natation. 
 
Communiquez avec le représentant du conditionnement physique des PSP de votre base afin qu’il vous 
assigne le programme de conditionnement physique des plongeurs-démineurs. Vous devrez alors lui 
fournir les renseignements suivants : 

1. votre nom complet; 
2. votre adresse électronique (des FORCES ou autre). 

 
Votre professionnel du conditionnement physique des PSP peut vous guider tout au long du processus 
d’entraînement et peut également surveiller vos niveaux de sommeil, de fatigue et de douleur au moyen de 
questionnaires. Le processus d’entraînement avec un professionnel du conditionnement physique des PSP 
est volontaire, mais comme le niveau d’intensité de l’entraînement est élevé, nous vous recommandons 
fortement de travailler avec lui, car il peut vous aider à devenir plus efficace. 

  



 

 

Annexe A : Comment visualiser le programme au moyen de l’application 
mobile 
 

L’application mobile Kinduct Athlete a été créée à l’intention des militaires. Kinduct a conçu un 

produit qui combine une conception intuitive, une utilisation intelligente des données et des outils 

de communication efficaces pour aider les militaires à rester en forme et à être plus performants. 

Dans une seule application mobile, vous trouverez des programmes d’entraînement et de 

réadaptation, des mesures et des rapports dans l’application, ainsi que des formulaires et des 

évaluations programmés. 

L’application mobile Kinduct Athlete est disponible aux fins de téléchargement à partir de la 

boutique iTunes d’Apple et de la boutique Google Play sur Android. Vous la trouverez sous le nom 

de Kinduct Athlete. 

Les deux versions de l'application mobile Kinduct Athlete prennent en charge les modes clair et 

foncé et peuvent être utilisées en mode portrait ou paysage. Nous vous recommandons d'utiliser le 

mode portrait, car il vous offrira la meilleure expérience. 

 

Connexion à l’application mobile 

Première connexion 

Inscrire l’information suivante à la première connexion : 

 Nom de domaine : Saisissez psp-research comme domaine. 

 Nom d’utilisateur : Le nom d’utilisateur fourni par le personnel des 

PSP. 

 Mot de passe : Le mot de passe est fourni par le personnel des PSP. 

Remarque : À votre prochaine connexion, le domaine sera retenu, de façon 

à ce que vous n’ayez qu’à inscrire votre nom d’utilisateur ou mot de passe. 

  



 

 

Utilisation de l’application mobile Kinduct Athlete 

Chaque fois que vous ouvrez l’application mobile, la synchronisation se produit et tous les 

programmes d’entraînement et les formulaires prévus de la journée en cours s’afficheront (ou les 

journées précédentes dans l’écran « Missed » [En retard]). Elle affiche également tous les 

formulaires nouvellement attribués et met à jour vos données. 

 

Page « Schedule » (Calendrier) 

La page Schedule (Calendrier) est votre « page d’accueil » dans l'application 

mobile Kinduct Athlete, et vous permet d'accéder aux formulaires et aux 

programmes d'entraînement qui ont été prévus pour vous. 

 

Onglet « Up Next » (Prochain) 

Par défaut, vous serez dans l’écran « Up Next » (Prochain) où vous pouvez 

voir/accéder : 

 Les séances de la journée même (Today) comprendront les 

programmes d’entraînement et les formulaires prévus qui doivent 

être remplis la journée même. 

 Les prochaines séances (Upcoming) comprendront les programmes d’entraînement et les 

formulaires prévus dans l’avenir; faire défiler la page pour les voir. Cliquer sur le nom d’un 

élément pour le lancer. 

Remarque : Vous ne pourrez voir que les éléments à venir selon ce que votre entraîneur ou 

soigneur vous a attribué sur la plateforme. 

C’est également sur cette page que vous pouvez accéder à l’icône « Settings » (Paramètres), située 

en haut à gauche de l’écran, qui est détaillée plus loin dans ce guide. 



 

 

Onglet « Missed » (En retard) 

Dans l’onglet « Missed » (En retard), vous verrez la liste des formulaires qui 

n’ont pas été remplis et des programmes d’entraînement qui n’ont pas été 

effectués. 

Chaque tâche prévue sera répertoriée avec la date d’échéance initiale, et le 

fait de remplir le formulaire enregistrera les données pour cette date 

initiale. 

 

 

 

 

Formulaires prévus (questionnaires) 

Si des formulaires ont été prévus (c’est-à-dire que vous devez les remplir à 

des heures ou des jours précis), ils apparaîtront sur la page « Schedule » 

(Calendrier). 

Remarque : Ces formulaires prévus n’apparaîtront pas nécessairement 

dans l’onglet « Forms » (Formulaires), qui est principalement réservé aux 

formulaires supplémentaires qui ont été mis à votre disposition (accès 

autorisé) pour que vous les remplissiez (à la demande de votre entraîneur 

qui, dans ce cas, vous indiquera quand le remplir). Il est possible qu’un 

formulaire soit à la fois prévu et à accès autorisé; il sera alors visible aux 

deux endroits. 

Une fois qu’un formulaire a été lancé (voir les images), les questions sont 

affichées à l’écran une à la fois. 



 

 

Vous pouvez à tout moment revenir au début du formulaire en utilisant la touche « Back » (Retour) 

en haut à gauche de l’écran. 

 

 

 

 

 

 

 

 

 

Si une question est marquée comme obligatoire, vous ne pourrez pas passer à la question suivante 

avant d’y avoir répondu. Dans cette situation, vous ne pourrez pas sélectionner le bouton « Next » 

(Suivant) tant que vous n’aurez pas fourni de réponse. 

 

 

 

 

 

 

 

 

 

 

Si vous décidez de fermer le formulaire, que ce soit à la moitié ou juste avant de le soumettre, vous 

recevrez le message sur l’image de gauche. Toutes les données saisies seront conservées pour le 

moment où vous souhaiterez terminer le formulaire. 

Une fois le formulaire rempli, un écran d’achèvement vous permet de le soumettre officiellement 

(image de droite). 



 

 

Remarque : Si vous n’êtes pas connecté à Internet au moment où vous soumettez le formulaire, les 

données seront enregistrées momentanément sur votre téléphone et transférées sur le serveur de 

Kinduct dès que la connexion sera rétablie. 

 

Programmes d'entraînement 

Pour les militaires qui reçoivent des programmes d’entraînement et de 

réadaptation de leur entraîneur ou de leur soigneur, l’application mobile 

permet de récupérer et de revoir les programmes d’entraînement assignés. 

Une fois que vous y avez accédé, vous pouvez facilement visualiser, 

modifier et effectuer votre séance d’entraînement. 

Les militaires peuvent également synchroniser les mises à jour de leurs 

séances d’entraînement avec la plateforme Kinduct. Vous pouvez ainsi 

utiliser l’application mobile hors ligne, en stockant les données sur les 

appareils au fur et à mesure, puis en synchronisant les données une fois en 

ligne. 

À partir de la page « Schedule » (Calendrier), cliquez sur le programme 

d’entraînement que vous désirez exécuter. 

Cette fonction permettra d’ouvrir le programme d’entraînement et 

énumérera les diverses sections des séances. 

Étape 1. Cliquez sur la séance d’entraînement dans la liste pour faire 

apparaître les détails de la séance. (Warm-up, Workout, Cool-down 

[échauffement, entraînement, récupération]). 

Étape 2. Cliquez sur la section de l’entraînement (Warm-up, Workout, 

Cool-down [échauffement, entraînement, récupération]) pour afficher les 

exercices de cette section. 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

Étape 3. Si vous effectuez l’exercice comme prescrit (LB, REPS, REST [charge, répétitions, repos]), 

vous pourrez ensuite appuyer le numéro à côté de cet exercice pour le marquer comme terminé. 

Étape 4. Cliquez sur le crochet dans le coin supérieur droit une fois les modifications saisies ou 

l’exercice terminé. L’exercice est ainsi terminé. Si la charge utilisée pour l’exercice est différente de 

celle prescrite, appuyez sur le champ correspondant pour saisir les modifications nécessaires – 

« LB » (Charge), « REPS » (Répétitions) et « REST » (Repos). En utilisant la touche de suppression 

pour supprimer une valeur modifiée, la valeur prescrite originale sera rétablie dans le champ et le 

texte redeviendra gris (jusqu’à ce que l’exercice soit marqué comme terminé). 

Étape 5. Cliquez sur le bouton de l’icône « i » pour avoir accès aux valeurs enregistrées antérieures 

pour l’exercice, la vidéo d’instruction et le texte (figurant à la droite ci-dessus). 

 

 

 

 

 

 

 

 

 



 

 

Étape 6. Si vous avez marqué tous les exercices d’une section comme étant terminés, la case à 

cocher de la section d’exercices sera remplie en orange. Autrement, vous pouvez également 

marquer tous les exercices comme étant terminés en même temps en appuyant sur la case à 

cocher vide. 

Étape 7. Une fois que toutes les sections de l’entraînement sont terminées, appuyez sur « Submit » 

(Soumettre) dans le coin supérieur droit. 

Étape 8. Après la soumission de votre séance d’entraînement, la section de saisie de l’échelle de 

perception de l’effort (ÉPE) apparaîtra (photo de droite ci-dessus). Inscrivez votre RPE 

(ÉPE) et Duration (Durée) puis appuyez sur « Submit » (Soumettre). 

Remarque : Consultez le tableau des valeurs de l’ÉPE ci‑dessous afin d’évaluer votre taux moyen de 

perception à l’effort pour la séance d’entraînement entière. 

0 Repos 

1 Très facile 

2 Facile 

3 Modérée 

4 Quelque peu difficile 

5 Difficile 

  6 

7 Très difficile 

  8 

9 Extrêmement difficile 

10 Maximum - le plus difficile  

 



 

 

Onglet « My Data » (Mes données) 

L’onglet « My Data » (Mes données) fournit l’accès à un ensemble 

d’indicateurs configurables déterminés par votre entraîneur. 

Vous pouvez y suivre vos progrès personnels, ce qui vous permet 

de comprendre les données qui se cachent derrière vos 

performances. 

Cet onglet vise deux objectifs : 

1. vous permettre d’accéder à vos rapports; 

2. vous montrer la « Daily View » (Profil quotidien) de vos 

indicateurs. 

 

 

 

Rapports 

En cliquant sur le bouton « View Available Reports » (Afficher les rapports disponibles), vous 

quitterez l’application mobile pour accéder à une page de navigateur (voir l’image ci-dessous; 

l’affichage peut différer en fonction de la personnalisation de votre organisation). Il peut y avoir un 

ou plusieurs rapports à sélectionner, selon ce qui a été attribué. 

Remarque : Vous devez être en ligne pour avoir accès à cette fonction. 

 

 

 

 

 

 

 

 

 

 



 

 

« Daily View » (Profil quotidien) 

Lors de la première utilisation (ou après une déconnexion), vous devrez 

configurer les indicateurs qui sont importants pour vous. Pour ce faire, 

appuyez sur le bouton « Edit » (Modifier) pour configurer les pages. 

Vous pourrez ainsi choisir dans une liste d’indicateurs (voir ci-dessous). 

 

 

 

Vous pouvez sélectionner les indicateurs qui sont 

importants pour vous ou que votre entraîneur 

vous a demandé de sélectionner. 

Il suffit d’appuyer sur les boutons (+) et (-) pour en ajouter et en 

supprimer. Vous pouvez également glisser et déposer les indicateurs pour 

modifier l’ordre d’affichage. 

 

 

 

 

 

Une fois que vous avez enregistré vos choix, la page « My Data » (Mes 

données) affichera les valeurs quotidiennes de ceux-ci. 

La date peut être modifiée afin de revenir en arrière un jour à la fois 

pour voir les valeurs précédentes.  

 

 



 

 

Vous pouvez sélectionner un indicateur (en cliquant sur le 

titre) pour voir son historique. 

Les données peuvent être affichées par période d’une 

semaine, d’un mois ou de trois mois : appuyez sur les 

commutateurs situés en haut de l’écran pour les voir. 

Les valeurs précises à chaque profil seront affichées sous le 

graphique linéaire. 

 

 

 

Définition des seuils 

Pour chaque indicateur, vous pouvez définir des seuils supérieurs 

et inférieurs pour voir facilement si vos performances sont 

conformes ou non à vos attentes personnelles. 

Sélectionnez l’icône des paramètres (située en haut à droite sur la 

page) et vous verrez apparaître l’écran « Enter Thresholds » 

(Inscrire les seuils). 

Vous pouvez saisir ici une valeur maximale (supérieure) et une 

valeur minimale (inférieure), lesquelles sont entièrement 

facultatives. Une fois les valeurs enregistrées, elles sont affichées 

sous forme de lignes horizontales sur le graphique linéaire de 

l’indicateur. 

 



 

 

 

 

 

 

 

Si vous avez défini des seuils pour l’un de vos indicateurs, la « Daily 

View » (Profil quotidien) mettra en évidence les valeurs qui se 

situent en dehors du seuil saisi (voir la section « Physical Wellness » 

[Bien-être physique]). 

 

 

 

Onglets « Forms » (formulaires) 

En sélectionnant l’onglet « Forms » (Formulaires) au bas de la page, 

vous obtiendrez la liste des formulaires dont l’accès vous a été 

accordé. 

Il s’agit de formulaires dont la notification n’est pas nécessairement 

programmée de façon récurrente, mais qui sont accessibles pour 

être enregistrés au moment opportun. Toutefois, certains 

formulaires ont des notifications (programmés pour vous). 

Appuyez sur le formulaire que vous souhaitez remplir pour l’ouvrir. 

 

 

 

 

 



 

 

Paramètres 

L’écran « Settings » (Paramètres) offre des options de configuration 

pour les notifications, les rappels d’entraînement et la connexion à 

votre application mobile Santé (si vous utilisez un iPhone – si vous 

utilisez un appareil Android, cette option ne sera pas disponible 

pour vous). 

La page de paramètres est accessible via l’icône d’engrenage située 

dans le coin supérieur gauche de la page d’accueil (« Schedule » 

[Calendrier]). 

 

Rappel des séances d’entraînement 

Les candidats sont en mesure d’ajuster l’heure de réception du 

rappel ou de la notification de la séance d’entraînement dans l’écran « Settings » (Paramètres). 

 

Notifications 

Vous pouvez régler les notifications de l’application mobile 

Kinduct Athlete à partir de la page de paramètres de votre téléphone. 

À partir de cette page, vous pouvez activer et désactiver les 

notifications comme vous le souhaitez. 

 

 

 

 

Lorsqu’un formulaire a été prévu pour vous 

et que les notifications sont activées, vous 

recevrez une notification comme celle 

présentée sur la photo de gauche. 

 

 

 

 



 

 

 

Connexion à l’application mobile Santé 

Les militaires peuvent connecter leur application mobile Santé d’Apple à l’application mobile 

Kinduct Athlete. L’activation de cette fonction permettra de prendre en charge les options 

d’intégration subséquentes. Si un militaire utilise actuellement l’application mobile Santé, nous 

recommandons de la connecter à l’application mobile Kinduct Athlete afin de fournir des données 

supplémentaires. 

Par exemple, les militaires qui utilisent des applications mobiles d’exercice distinctes ou des 

applications mobiles de sommeil intégrées à leur application Santé (avec la fonction HealthKit) 

pourront facilement consulter leurs renseignements sur l’application mobile Kinduct Athlete. 

Les militaires peuvent modifier l’information qui est transmise par l’application mobile 

Kinduct Athlete sur cette page. 

 

Déconnexion 

Vous pouvez choisir de fermer l’application mobile lorsque vous avez fini de l’utiliser ou vous 

pouvez vous déconnecter à partir de l’écran « Settings » (Paramètres). Si vous choisissez de vous 

déconnecter, vous devrez saisir à nouveau votre nom d’utilisateur et votre mot de passe lorsque 

vous ouvrirez l’application mobile la fois suivante. 

Kinduct utilise des mesures de sécurité pour protéger les données stockées sur votre téléphone et 

transmises sur la plateforme Kinduct. Par défaut, vous resterez connecté à l’application mobile 

pour des raisons pratiques et pour recevoir des notifications. C’est donc à vous de protéger 

adéquatement votre téléphone à l’aide d’un code. Comme vos données de connexion sont 

mémorisées, certains peuvent décider de se déconnecter afin que d’autres personnes ayant accès 

à leur téléphone ne puissent pas ouvrir l’application mobile et accéder à leurs données. 


